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1.1 PC BERECH
1.1.1 CPU ZEVVESE 2.0 GHz 5l | - 2 Intel 64-bit
CPU -
1.1.2 PVEZEA 1 {E=L _ERY USB 3.0 port » k(A Intel 7Y
USB 3.0 host controller -
113 EREAENERINEEER 2GB -
1.1.4 WEEE A HAESERNEEERL 512 MB -
1.2 OSIEEE:
1.2.1 /AR Windows 7 55 #HY Windows f A4S -
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1.2.3 F % Windows OS 47T Windows Update ZZ4E5¢8
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2 Z25E HiBestViewer #R{4E
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Welcome to the HiBestViewer_0.90.003 Setup [_‘I
Wizard e ot |

The installer will guide you through the steps required to ingtall HIE estViewer_0,90.003 on wour
computer.

WARMIMG: This computer program is protected by copyright law and intemational treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted ta the masimum extent possible under the law.
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. Microsoft DirectX SDK (June 2010)

m

-

RENH=RE

mRER

R RSE

2-4 1£ Windows f2= £ 11/ HiBestViewer Program Folder
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F=F Acquire View » IS

AR AR A HiBestViewer Y Acquire View s HIE S s 4E
B DR et AT AN S images © AE DL “Python & 2 HE AR B2k Esn
Bﬂ o

1 LR

1.1 H&HR&AY USB 3.0 cable (REFE/NA 3 A R)E B = R I
T EL PC Uty USB 3.0 port » %5 PC Uil = 2R HEAHR 2 ]
HIPEEERR ZE AN 3 AR - FERER “mlohEfH2 e 5HY USB 3.0
hub”/&H7EE 1 PC Uty USB 3.0 port J /= 2R BRAHE” -

1.2 & PC Bi“=7RIafHi% #& USB cable #H#i$#%1% » Windows & 5 &}
E sy = 2RI 2 Windows BEEkThat e B E# A s
ZREAE I 2225 drivers -

1.3 %5 Windows 15975 Hrask = 2R B - (L E B ET-E)
LG ERIE AR HY drivers > s ZRHEAET R B M A “driver
setup program”H HE i I F T2 -

2 1T HiBestViewer

2.1 % HiBestViewer fE{EH LAFT HiBestViewer EHFE -
HiBestViewer i {T1% » “FHEz% &/ HEFLE Acquire View »
RIEEfE F & & Se B EIAIEZ Acquire View o

2.2 IR PC ESep&de s atate” - mH e/ A —&6"5HE
FHt% B PC HEE 45 | - (I REEFIWE 3-1 fYEHE » 1F
3-1 & HiBestViewer (£ HIE]— &5 R IGHHIE” - W EHE)
R R Ry H A - Al - 1EfE 3-1 /Y Acquire View 55
e R R AR Y sensor type W HEHEATA RIS ERYEEH » A
Preview FYIfIEE °
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File View Help
Acquire View | Stip View | Working View

(2] (]2

Receive Frame Rate
Diaply Frame Rate :

Ready

Camera Settings

Exposure Time :

Gain :
Record Settings
Max Frames
Record Frames :
Record Time :
Trigger Settings
U
0

(sensorType:  PYTHON1300 )
Resolution : A1280 *1024 -

:lOms v
(1 E

50

Trigger Precentage :

Pre-trigger frames

Time

Post-trigger frames :

Time

2181
2181
~218 sec

19 %
436
~44 sec
1745

~17.5 sec

23 &2z

R RAT A Y S E

[l 3-1 MEA (2 5 228

HAE A Ry

HEAEEFEIE 3-2 (VEH - FrANERSE BZEH
TEEVE » IEHF Preview AYIHRE

A -

;) HiBestViewer -09.03

»

File View Help

I Acquire Yiew |Strip View | Working View

it ‘ 11 }9‘

Receive Frame Rate

Diaply Frame Rate

Ready

SETH AL R

[ camers settings

Sensor Type :
Resolution :

Exposure Time :

Gain:

Record Settings
Max Frames
Record Frames
Record Time

Trigger Settings

0

=]

50
Trigger Precentage
Pre-trigger frames :
Time
Post-trigger frames :

Time

19 %
436
~44 sec
1745

~17.5 sec

3-2

LHEE] SR

77

AN

SEIEE i M-

12



2.4 55451 > HiBestViewer SEFENF H BN {2 &4 = 2R TR A [
& o KNI - Z= (B AL HiBestViewer $i{T1% - FH#2 L s 2fia
FE#%” > HiBestViewer 45L&/t |- 10 ~ 20 Fh(HEHFRIEFE T
Windows %f—(f##s%r) USB device (DAJE MR E /G R S stk
SRR, AR AT - SRR S B B RAE R E 3-1 WS
@ o

3 Acquire View FYThEEEREH

DUNHIZhRE VR m 2R I AR i ENEA 8 | PC BRI T J758E

PRAE

3.1 Camera Settings : HiBestViewer $& {25 F & u] DAIZEdEAE

TR B = (AR 28 - AfE 3-3

3.1.1 g%iE Camera Resolution : FHAFEIREEST LRV S A
PR > R R RS il R e P TS B A e =
EER AR -

3.1.2 #5E Camera Exposure Time : FHiNEEE S 7 FRAVIR
WFEATR - BT AR E i B R ed e HE A A
FIEE G IR -

3.1.3 E%iE Camera Gain Value : FHAMHBEEE S FrHYHE 25 (E
AR > FTLAEERCE L R e A B A
B ARNY mE -

FAN - FEIEEAT Preview(EEHUG) TG > A EEE

AR

File View Help

Acquire View | Strip View { Working View

PYTHON1300
1280 * 1024
10ms

eeeee
Receive: d Frame Number : 980, Spent Time : 9.73, Received Frame Rate : 100.68

Processed Frame Number : 980, Spent Time : 9.75, Display Frame Rate : 32.62

R 3-3 B AL A S
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3.2 Record Settings : {1[& 3-4 Fi7~

3.2.1

3.2.2

3.2.3

3.24

Max Frames : [HiAg fir 20 H AilE: % Al 7Y G AL
images 5RE o Ry —(E &ML - A MG ESTE
o o e {Ef A VR H & e H AT A4 0 FRYEL RS
&7 —5k image FrfEAVELREA 2 HVE L 2 X

8 o NI EEAEAEREN IR v E - T

AIDARARA— e A R E AV EAFE - MRS Acquire

View Fll#Fr2E (40 © B Strip View 5 Working View 1]

#a[a] Acquire View 5t &< Acquire View [l EER) - &

AU EREIE0 PC HYELIRRE S B g H R -

Record Frames : 35 7E i 27 A 4E HI 5 images HY5R

B (EHE AR E I 2 7 KRS LA Y EE » 2

& B BRRAE A RE 2 i — (& A7 (L2 Max Frames)

B/ IMELRME KT 0 -

Record Time : {748 A images IVFF IR - 272

—{E&EHM - SAMEESEN - EEBEOATER

HYE 2 iR1% Record Frames (i B FT#s - IFRILAFD R E

fir »

Trigger Settings * 5% € BfA A7 & HUE: images HYf§#

I8 > s 2L 0% ~ 100% ek E&E » BINE

FUT -

32.4.1 FEixiE(E Sy 100% - HIIFR R EaEt% - K 100%(:h
BRI EEC B ISR -

3242 WMREEEF 0% - RIFR 1% - K 100%(:h
TriBRE % FTEUSHIRT 2 -

3.243 WEHEZEHEEN% > fiin>0 H n<100 - HIFE
TN R (ERCERE TR AR n%rY
images - (Rt » ZRS & EEFHFEfEREE
T R A GY images LAGCIEAS » B
FIHH 2 8 HE e e HYsREL - B2 FHL Record
Frames [{Y{E 7 _F(100% - n%) =2 (i A & 58 Hl{F
b T HER & (Preview)” » Z & FHRFECISHE T
FTHUSHY 48 images & EBEEE T 2K -

{5 P& 75 (5 AV B8O BRLFLL ) Trigger Settings Bar 5% 7€ %

SL'E - i) Trigger Settings Bar FT{qAY St i Ea

A& ERAIEE R Y Trigger Settings Bar 1~ J7 » HABEH

SEBIEIT - (A& 3-5 FTR)
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3.2.4.4 Trigger Percentage : EE ~f17Ef) Trigger Settings
Bar 12T {3AVEEE(E » Hh#EE 0% ~ 100% -

3.2.4.5 Pre-trigger frames : fif=$Hi L FHY frames 7f
Lig

3.2.4.6 Time (Pre-trigger Time) : fila¢ g #E 20 8RAYRT
f] e

3.2.4.7 Post-trigger frames : fif=51% Z 4L £E{FHY frames
TREL -

3.2.4.8 Time (Post-trigger Time) : fifj&&1% B4 S0 eR S
f] e

pm—
“a;) HiBestViewer - 0.9.0.3

File View Help

Acquire View | Strip View | Working View

Camera Settings
Fit 11
Sensor Type : PYTHON1300
g .

TR Resolution : 1280 * 1024 v

‘l Gain :
l
|

i /@rd Settings \
Max Frames : 3920}

k:', . } Record Frames : 3920
L ‘I ‘ Record Time : ~39.2 sec
> y 4 Trigger Settings
< | 0

- o 0 50 100
I Trigger Precentage : 20 %

Pre-trigger frames : 784
Time : ~7.8 sec

Post-trigger frames : 3136

K Time: ~314 j

Received Frame Number : 880, Spent Time : 8.74 , Received Frame Rate : 100.73

Processed Frame Number : 880, Spent Time : 8.74, Display Frame Rate : 32.51

Ready

3-4 Record Settings [&HE (17 B
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o HiBestViewer - 09.0.3
File View Help
Acquire View | Strip View | Working View |

Camera Settings
Sensor Type : PYTHON1300
j:i i : — “"7' = Resolution :
‘g. 5 | Exposure Time :
|
} Gain :
| { Record Settings
4 Max Frames : _@
“ ’ Record Frames : 3920
e l , Record Time : ~39.2 sec
> A y Trigger Settings
< | (JET
- g 0 50 100
Trigger Precentage : 20 %
Pre-trigger frames : 784
Time : ~7.8 sec
Post-trigger frames : 3136
Time : ~314 sec
Received Frame Number : 880, Spent Time : 8.74, Received Frame Rate : 100.73

Processed Frame Number : 880, Spent Time : 8.74, Display Frame Rate : 32.51

Ready

3-5 Trigger Settings Bar &HE B

3.3 Preview : BE3E Preview button EgEhfH % » —HEE images &4%
7 USB #£[0] PC W B8~ 1E Preview Window 2 f - 524) »
“Preview Progressing Information™fi7 /> Preview Window f
77 0 e R B EE R ENY image frame (Y5 E Bl A0 B YRS
(DA By BEAr - ELKSARE) NECEERAfir) K frame rate (JREISF) 2%
DiR)yEEEN - fifsE ¢ FTaH Received Frame Number 25 E & H
FHF%3% (0] PC |y image data 5558 » [fj Processed Frame Number
=15 application ELZHH##IY image data 5&E » fEIEFE AR Z
T EEEEE —2 - (A06E 3-6 FR)
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[ HiBestViewer - 0.9.03
File View Help
Acquire View [Strip View | Working View |

| Camera Settings
Sensor Type : PYTHON1300
: gl e [mios )
( ‘ Exposure Time:  [10ms v
J Gain: |1 =)
l 1 Record Settings
Max Frames : 5929
N Record Frames : 3920
! : ;
Preview Window - Record Time : ~39.2 sec
- S
2] Trigger Settings
- * 0 50 100
Trigger Precentage : 20 %
Pre-trigger frames 784
Time ~7.8 sec
Post-trigger frames : 3136
Time : ~314 sec
Preview
Received Frame Number : 880, Spent Time : 8.74 , Received Frame Rate : 100.73 A——
Processed Frame Number : 880, Spent Time : 8.74,, Display Frame Rate : 32.51 > . A
Preview Progressing Preview Button

Ready Information
— —

3-6 Preview (ZE4EH{%)

3.4 ZH%Z Preview Window ¥} image HYE~ © { F & 0] DLFHEE
image data 7£ Preview Window FHVEERT7 =, - Acquire View H
ATSZ R DA MU~ 7= > DURJSCR4E/)N(Zoom In/Out) -
3.4.1 “Fit” . =& 2 Fit to Window » tZ5fE < Preview
Window HY A/ » FHIEZSK B B RETUR -

342 “L1": EHTE BRI image (TN » FIH
image YA/ NEB AR ZE A Preview Window [/ »
Rt - EFREE B REZCT - AR A8 H & EF] image
HIER T ©

A (5 HURE I EURE SR T FERY button R[THT %] Zoom

In/Out - (401f&El 3-7 A7)
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(5 HiBestViewer - 09.0.3

File View Help

Acquire View |Stiip View | Working View |
_y Zoom Out

=
) ul |ﬂ| Zoom In

Display Mode

£

Received Frame Number : 880, Spent Time : 8.74, Received Frame Rate : 100.73

Processed Frame Number : 880, Spent Time : 8.74, Display Frame Rate : 32.51

Ready

Camera Settings
Sensor Type :

Resolution :

PYTHON1300
(12801024 -

Exposure Time : ’10 m: -
Gai \1
Record Setting
Max Fram: T BB
Record Frames 3920
Record Tim ~392 se:
Trigger Settings
U
0 50 100
Trigger Precentage 20 %
Pre-trigger frames 784
Tim ~7.8 sec
Post-trigger frames 3136
Time ~314 sec

3-7 Display Mode k2 Zoom In/Zoom Out

3.5 Stop “Preview”J; “fE{F#4E images” :
B #AH 4 H {5 (Preview) - Stop button xt & 4% B (4[El 3-8 Fit

eSS CUNREL

ST > TT{sE F 3 B DA R B35 Stop button 2842 1F DL R EE
3.5.1 Stop Preview : — EEE#E Stop button - Preview Ef{F &1L
HE L AGAEEE R B Preview B (EATHIR

HE o WS Preview button EHTELA  1fij Trigger

J¢ Stop button RIJ#HZ=H] - (41fE 3-9 F7R)
3.5.2 Stop “Preview” Jz “f# 7% images” : B Stop
button » H &AM - I > 4RI EUNAT

HEFEFAYRE - (AE 3-10)
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File View Help

Acquire View :Sbip View ] Woxkinz View |

Camera Settings
Sensor Type : PYTHON1300

Resolution : 1280

Exposure Time : 10ms

Gain:
Record Settings
Max Frames :

Record Frames :

Record Time :

Trigger Settings
0 50 100
Trigger Precentage : 20 %
Pre-trigger frames : 732
Time - ~7.3 sec
Post-trigger frames : 2928
Time : ~29.3 sec

Under previewing,
¥ The “Trigger” and
“Stop” button are

Received Frame Number : 540, Spent Time : 5.30, Received Frame Rate : 101.81 enabled.
Processed Frame Number : 540, Spent Time : 5.32, Display Frame Rate : 32.15
Ready
= . . NN .
3-8 Previewing jjkHE 2 NHY Trigger k2 Stop button
 HiBestViewer - 0.9.0.3 H =
File View Help
Acquire View | Strip View | Working View |
[ | Camera Settings
| At | |22 Pl L ?
‘ Sensor Type : PYTHON1300
Resolution : | 1280 * 1024 v
Exposure Time : |10 ms - ‘
Gain: (1 v
Record Settings Pl’OIl’lp t
rames : 3660 Message -
rames - 30— | M Preview had
Ston Sblimene Time - ~366 sec been stopped
|[F Settings
| u
50 100
I ’ — recentage : 20 %
Pre-trigger frames : 732
Time - ~7.3 sec
Post-trigger frames : 2928
Time : ~29.3 sec
“Preview” button
had been re-enabled,
Preview but “Trigger” and
Received Frame Number : 260, Spent Time : 2.50, Received Frame Rate : 104.17 “StOp” button had
Processed Frame Number : 260, Spent Time : 2.50, Display Frame Rate : 30.85 been disabled
Ready

3-9 HE35E Stop button - {52 F Preview
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55 HiBestViewer - 0.9.0.3

File View Help

| Acquire View | Steip View | Working View |

=] 2] 2]

41-31bsi].

Received Frame Number : 370, Spent Time : 3.62, Received Frame Rate : 102.24

I
=)

Processed Frame Number : 370, Spent Time : 3.62, Display Frame Rate : 31.50

Cancel save video file to --> [ C:\Best
Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-10-

Camera Settings

Sensor Type : PYTHON1300
Resolution : 1280 * 1024 vj
Exposure Time : 10ms v |

Prompt

4 Message :
Trigger had
been stopped

~10.0 sec

Pre-trigger frames : 200

Time : ~2.0 sec
Post-trigger frames : 800
Time : ~8.0 sec

“Preview” button
had been re-enabled,
but “Trigger” and
“Stop” button had
been disabled.

Ready

3-10 L5 Stop button - {52 1F Preview k2 Trigger

3.6 Trigger : (A& RE) 1 AHIEBAAAESTH B (Preview) > Ly
Trigger button j&F (2RI AH (418 3-8) - 1 {5 A =& w] DARE < R 25E
Trigger button S\2{s F /Ml Ha Al - BRIGHEE
images - —H 3% > RIIIERSIALT -

3.6.1

3.6.2

3.6.3

3.6.4

IR A BNV E R e BT A & il s
(i B 5 E Y 3H4E images (FE4TERAAEE S AL 3.2.4 Trigger
Settings HYE7HA)

HF B R % > H i RSeR 74 images Al >
JeBhi5E T Stop button > FRJEEREE B 57 2448 images
HIBHE - 552 R, 3.5.2 AYERHA -

TE (k77448 images HYBFE > (FRE/ T E L g8URE
FE A FR R 3 E RTEVAERE AR « 5591 - Trigger button
S A I AR > A00E 3-11 FR -

S 74 images IVBHENEFISER > 2T EE)
{11 Preview » WGAE (S &7 Al R Gh7E HAE
images & Z2 1Y 5 B ER A R A A4 R e fUE (2T 1E] 3-12
i) o 1 HE i B OKBARAFE i EE » 248
& E BV Strip View o
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. ——
ad HiBestViewer-09.03 NI

File View Help

Acquire View | Strip View | Working View |

i i 2 2

Received Frame Number : 780, Spent Time : 7.72, Received Frame Rate : 101.01

Processed Frame Number: 780, Spent Time : 7.72, Display Frame Rate : 32.63

Camera Settings

Sensor Type :

Resolution :

Exposure Time :

Gain:

Record Settings

Max Frames :

Record Frames :

Record Time :

Trigger Settings

0
Trigger Precentage :

50

Pre-trigger frames :

Time:

Post-trigger frames : 800
~8.0 sec

Time:

Grabing video data please wait....

" =
[Lrts [ st

Ready

& 3-11 Trigger #E77 0 AY{HE A&/ IR

L3 eviViewer ‘

File View Help

| Acyoen Varw S%p View | Working View

‘r-a S CRRNC)

Camara Settings

“Trigger”
Progress

< -Trigger“
* button had
been

disabled

ation

Sensor Type PYTHON1300
Resoluticn 12801024 -
Expotre Time 10 ma -
|
Gan 1 -
Record Settogs
25
Ingger oper
1000 .
successiul prompt
~100 sec TREIH
Save wdeo fle 1o > [ C\Be: message
Intech\MestViewer_0.90 0035\VideoFile\2015-04-10-05-12-42 b | 13
wucceed
0 100
gegtage 20 %
y fames 200
| < >

nabled.
and

Time ~20 sec
Post-trigger fames 200
Time =80 sec
Preview™ button
had been re-e
T ] 4% but “Trigger”
Received Frame Number : 1260, Spent Time - 12.56, Receved Frame Rate : 1003 “Stop" buttor

Processed Frame Number 1248, Duploy Frame Rate : 328

Ready

& 3-12 Trigger 5ER4 & AY{EHE A&7 R

1 had

been disabled
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SBUUEE Strip View » B MGG &

A EERBHAN{E] {55 A HiBestViewer [ Strip View 2 ¥ 47717848 images
BEVER » 5E By A-B Play s & -

1

WA ZE Strip View

HLUT == DLYJ#AZ Strip View :

1.1 HFEAEMAE S LR 8 RS Strip View tab control (411[E]
4-1 FoR) < EE - 2 AR RBUAE—E LRI T E
SAGRIEZE » HRIEE Strip View & 23—/ 220 - 5550 > HAQ
Strip View HEE—XGARL—(EHE T GIEE -

a. HiBestViewer - 0.9.0.3

File View Help

| Acquire View | Strip View | Working View |
OO0 2= @

4-1 HE3EE Strip View tab control

1.2 H Acquire View fi§§# » fEFERCEER SR © 2 EEUHR
2 Strip View([R By 22478 5 B Bl By (o & B B 1 (517 50 e 2
B BAE)  FFHEIE R 2R FE =5 3.6 25 -

1.3 {EHERR—E AT R Y 5 - RS REA
B
13.1 B85 menu #247) File=>Open (411[E 4-2 FF)

o HiBestViewer -09.0.3

(_File DView Help

% Working View

B ©

4-2 B E ARV SRR
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132 2% » Z& R (BN Windows A% 2835 /1
(A& 4-3 F7R) > (8 S A A B AR R R R A
% —HFEBEZEKI(WERTS HiBestViewer [EHFE
ATERAVIE IS » A ARERIIFRY) - R%mE
Y] 2 Strip View -

»

s/ HiBestViewer - 0.9.03
-—

File View Help
Acquire View | Stip View | Working View
(O] m == [EOY

/ o MEES

( ) | ) » ®E » Windows(C) » Bestintech » HiBestViewer 0.90.003 » VideoFile

EaEA v FRARHR
L BENOE z
3 Dropb.
N " |_| 2015-04-10-05-12-42.bsi
. |_] 2015-04-10-05-43-03.bsi 2015/4/10 = 0.. BSIEE 1,280,00)
© MySyncFolder
BTE

ey
]
Subversion
@ xe
o =
B ==
= EA
R PLChen
- R
O 52

WEZWN): 2015-04-10-05-12-42 bsi - {Eﬂ.(‘.bsi)

| mema0 |+

[ 4-3 J31%E 0 BEE A B AR 2K

Strip View FHEEEN
— HEIhBRRL T — {2 4E images BRHE » A2/ DE i HE
EEFLUT 6 MFFREER  WlE 4-4 Fror
2.1 REFEAVFEEEEL{CATE(full path name)
2.2 7HF image ERAVEMEER]
2.2.1 Length @ f5483LrY images 5R%E - DR 4-4 K5 - ‘EFT
RURHYEE AL images 5RESy 1000 -
2.2.2 Frame Rate : PP HUSAYIREL - DUE 4-4 Fsfol] » ‘EFTE
HY Frame Rate f&4&F) 99 5E -
2.2.3 Image Size : image FYEE(GZLL pixel BEAL) - DUE 4-4
Ryl > ‘EFTERAY image s2R R Ry 1280x1024 -
2.3 7H%E images HY4ElE - D7 (EEHEEORE o (WE 4-4)
2.4 BURNEBAURNTRIE ¢ AR —5R image A AR 0 B
JEEAER% 5 image @G N AR~ —ER e E LT
FH AR —5f image #ZAaC0 -
2.5 f—7E image 1Y frame number » FRFAETEE images 45 &Y
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File full
path name

Attributes of,_|

images

< | C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

I N FEAE 4-4 SRR E SR G 4alE o i frame number HY4RHE
AR -

25.1 {EfE3ArEAARTE image Y frame number % 0 o

2.5.2 1F frame number 0 7 FijAV 745 images @ T {fHY frame
number A& - (IKFAH] 0 B—5E frame number 2
1o

1£ frame number 0 7 1& /Y7848 images » E{"#Y frame
number & 8 > {XFF1E% Y —5E frame number #EHg
1o

—75k image HYHUGAHEIRFRT - S HUEAE B R st~
Fir¥ € images 4E[EHY/S T » WAL frame number #Y 75
B BEALERD - (H A2/ NEGEEETUAL(E o 2 —1) » AlfE]
4-4 TR RS YEE o T EUGAH SIS RV RHER R0 T
2.6.1 fEMEREALEAIARE image HYEUGAREIIFH f 0 -

2.6.2 {EHUGAHEIE & 0 Z FiaYH#4E images » EAMHIELE:
TR R B R AERTIR

TERUGAHEIR I By 0 2 12148 images @ EfTHVEUE
TR R Ry (R KPR AR -

2.5.3

2.6

2.6.3

o) HiBestViewer - 09.0.3

File View Help
[ Aoquie View | St View | Working View

Om == o)

List of
y i thumbnails
! n of images
R4 |
FrameRate : List of
99 fps v frame
Image Size : / be
1280X1024 I numbers
(00303 00202 00101 00000 | 00101 00303 o040 Ml pitof
43 iR
7 Sign for relative time
indicating
bookmark
H . £ Ak ks
4-4 Strip View F#EEE ]
Strip View fafRi#EEf

bR TARRE AR 21 o Strip View EEHL T S AEEH BN RAVIIRE

 BFERRER ST ¢ BB Strip View tab 2 NHY Icon Bar i
HY 7 {[& icons » AT 7 FEA [EHVEHENAEARAYIIEE - 55 EBr 2 E
4%t Scroll Bar 5z Zoom In/Zoom Out Bar HYEfBIfs R IhEE - (Z1[E] 4-5
Ffi7T)
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-
a5 HiBestViewer - 0.9.0.3 v
i, o il

——

Il Fle View Help
Icon Bar ' fine] S Vi (oY
“{O@D:@mo]
i C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi
Lenth: ---mm-m-
1000
FrameRate
99 fps
'":z%zifszz NN (N N N N A N m—
oosos oozoz o001 ooooo 00101 oozoz oosos 0008
« » Ir,
g
Scroll Bar / Zoom In/Zoom Out Bar
4-5 Strip View eI ThEE
BT Icon Bar MRS FEAIE I e R ThEE - RS BB R 5
HIIERY icon HIHT - (41E] 4-6 FT7I)
|| Acquire View | Stip View | Working View
Ol |:11|:1 ][
o 4oy N N N
Time Align Frame Time Frame Marker Top Preview

Align Line Ticks Info.

4-6 Icon Bar fygfREHEBIThAE

Icon Bar Ay Ehta R LhRE A0 T

3.1 Frame Ticks : fif}f icon bar i /= #5853 S5 IU ([ icon » FHE B2 Bk
EIE icon m] GERERARA R BiE R R (B &1y Frame Count
Meter) - & &4 E%# K (Frame Count Meter)BARIHS » fE22{%40E
BRI AT 7 R —(E2EGuEE (Frame Count
Meter) - 1fij H. Frame Ticks icon & F73% B A HELRAE(E (FBREN
FHEGIRAE) - {58 FH & w7 Bk 58 Frame Ticks icon {5 b4 BX
JeRRRA = 5950 TG e IR N T B — Y= e
P - F—lEafE P esH% E— e gaEEn s
B FARFREE ORI 2R LT s GatE - (5
HLIRESINEZ S5 0BG R EAIE - TR
EiR o BE < [EHIRINRE K PTE L E - (WEl 4-7 FR)
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Frame‘Ticb Icon
||\ Acquire View | Strip Viey' | Working View |

00 Hoees @

C:\Best Intech\HiBestViewer_0.90.003\VideofFile\2015-04-10-05-43-03.bsi

Lenth: m----m-m

1000
FrameRate :
%9fps ) ) |
Image Size : -35 -24 -13 9 20 31
1280X1024 -0 3535 02424 -0 1313 0202 0.0909 02020 03131

) List of y lo’w rectangles
14242 ’

! | J[lH\IIJJ\ l | Liiitiltl

HH!IHl L1l

e DM

T A
.u:», 0.3131 04242 Frame§Count Meter

‘ {

Time Line Icon

4-7 Frame Ticks IHEE

3.2 Time Line : fifjf icon bar Y/ 885K EE =& icon » F)& & BL5E
IHt icon ] GE R E R PANF T R CR EE 1Ry Time Line) » EHFREIR
(Time Line)BARL » £ Scroll Bar b 77 &R —(@RFH K (Time
Line) - [fif H Time Line icon & 3% B5 (AAESRAE L (FRRIE T B
BLIREE) » A& 4-8 o »

I Acquire Vxew Strip View | Working View

E=EEE

\ C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

Lenth:
1000

FrameRate :
99 fps

Image Size :

1280X1024

-35 -24 -13
03535 02424 01313

‘‘‘‘‘‘‘‘‘

31 o Listofy low rectangles
0 2020 0 3131 4242

; 53 01313 3 ,.‘ 03131 e T e Lme Meter

4-8 Time Line IffE

3.3 Time Align £ Frame Align : :RA{E icon 43 Bz icon bar [y

R
Line By R{FEEA AL >

3.3.1
fry BB -

3.3.2 [NfE Time Line HYEE < EEAL G A [ERF B -

— AT -

{68 F & #5535 Time Align icon >

— {52 (i icon » FERA{E icon s 2K VA Time
B—TE 2 DARF ] Ry BE AL
FERAL > AaEALUT PR -

HAHE Time Line {E5aRIAVIFE -

5 RS DAIE S
A& 8E7 Time Line
HRE B

eHRE N BRI DA S LU S
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R B RN (DAY B BEAT - A2/ N EESEIUfY) » 40 4-9 5 2
Z [ FE R EE Frame Align icon » JREEE R B UJHARC DA
e R BT > 4fE 4-10 -

Time Align
I Acquire View | Stip View | Working View
O 20=mts ©
]\C_\,Besl Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

!II!“I!!I!!I!!IE!I!!I,
Lenth : — - —— - — - — - — = —
1000
FrameRate :
%9 fps . 1 ' J J | | |
Image Size : -35 -24 -13 -2 9 20 31 42
1280X1024 -0.3535 -0.2424 01313 -0.0202 0.0909 0.2020 03131 04242
r_; 3535 E ).2424 01313 -0.0202 - 0.09 . .Z‘:ECC‘ 0.3131 0.4242 h ]
¢ ) kL
Relative 'I"igc
4-9 Time Align IfigE
Frame Align
4 :
Acquire Stoip View | Working View

OoEE=H @

\ c \Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

Lenth: mmgmmmm-

1000

FrameRate :
99 fps N D D B _ _ I —
Image Size : -35 -24 -13 -2 31
1280X1024 -0.3535 -0.2424 -01313 -0.0202 0 0909 02020 03131 0 4242
TITTTIT T TITTT
: 9 20 31 42 )
r's » 5

Frame Number

4-10 Frame Align IhgE

3.

S

Marker : fir /s icon bar FY/Z B AR E LE - B2 AR VB
SVEERAF comment ZE R 4l L (FH 8 B 7% Marker icon 7
i) - EFRRUGEIR comment B - BRI 525 4 E 0V R
o K2 BERARANgEUR o (WE 4-11 Fi7R)
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Marker
4

Acquire View SmP VIEW

king View

[ C \Best [ntech\HlBestVlewer 0.90.003\VideoFile\2015-04-10-05-43-03 bsi

Lenth:
1000
FrameRate :
99 fps
Image Size :
1280X1024

I DN DN —
0 1 2 3 4 5 s 7
0.0000 00101 00202 0.030 0.0404 0.0505 0.0606 0.0707

| | | |
f T t T
1

v
Comment displayed in
thumbnail

4-11 Marker IhEE

3.5 Top Info : fi}f icon bar By /F2EARENME - B2 KU

B ECRHEAR R A-B Play W& B a0 (& (FH 8 BB 28 Top Info icon 2K
fB)#A) - FirEd A-B Play l& B 8 B Ha{E =R lHE e —EL
B RHVEE - EEEIEATEE AR Ry A B o ARG R
B & o £ U{ATTEE A-B Play & EL#EE R A IEE 5-1 {FER

HH o 5540 > HRTZR&GEA S HEE—(E A-B Play & Ee#iE] -
RS A-B Play & By #EIRY - s iGbaE T din—
RRALERIE R S FIFTA 1E A-B Play & Byl 2 Y2548

e - DA 4-12 S5l » A-B Play [&ES#a[EIHY A Bh Frame Number
-4 > 1 B %5 Frame Number £ 6 -

Top Info.

l Acquire View | Stip View | Wo, e | A-B Range Information

O@DD@ ® A

FrameRate :
99 fps

Image Size :
1280X1024

3.6

4-12 Top Info ZE7< A-B Play [& & [E|

Preview : iz} icon bar 1Y/ 2 HEE CEGEZR—E) - E-H
ARV HA B B B PR (8 FH 5 P B8R B 55 image(FH i B RL 28
Preview icon 2 i) #A) » {587 m] DL EERGEE @ﬁl%ﬁ
HEEY o WEEEE ARG A R g AR T R IR o EBERL

preview B - {1 & AT EUN 5215 o SE BN BN HT LAY AR
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& (A8 4-13 AR) © 5991 > EEAE SR T — B

G aEE TREA L TR Gl - AR TRERR

preview > Z&t L FRURE B SR BV — RG> if

GERZRE G -

w» Preview

l Acquire View | Strip View | Working View / i
== Selected thumbnail

OO = (o] s
l C:\Best Intech\HiBestViewer_0.90,003\VideoFile\2015-04-10-05-43-03 bsi

ja_fu

Lenth:
1000

FrameRate :
99 fps

Image Size : -10 -2 2
1280X1024 O 1212 -0.1010 -0.0202 0.0000 0.0202

4-13 Preview 214

3.7 Scroll Bar : Fi/5 e B s fi1E)) Scroll Bar R[#&HH4E 1 (G 4EE > <

58 FHERES A B R AL i (8 I M S MR U Ay s (G il > A7

SeENERT - LU EIESCR - (AE 4-14 FTR)
| Acquire View | Strip View Workmx‘hw

Lenth: - — — - —
1000
FrameRate :

99 fps
Image Size : -12 -10 <
1280X1024 -0.1212 -0.1010 -0.0808

> Scroll Bar

4-14 Scroll Bar HIfiIL &

3.8

Zoom In/Zoom Out Bar : A& B BLEE S 78 Zoom InfZoom Out
Bar ] AR/ NBIE 5 4 Ay & > 200 4-15 Fow
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Acquire View | Strip View | Working View |
(O)m)jf=! D-\D (O

] C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

Lenth
1000

| | 1
T

FrameRate :
99 fps

Image Size : -12 -10 -8 -4 -2 2
1280X1024 -0.1212 -0.1010 -0.0808 -0.0404 -0.0202 0.0000 0.0202

-12 10

Zoom In/Zoom Out Bar

4-15 Zoom In/Zoom Out HY(I1 &

4 REEPGERETRK—BE HAY video file

RCENBRRL— (I #4E images ERIME% - (0 HE TN AT R = (E 4
images & RHMERE{F R —REHE A video file 22 —5R5RAY bitmap
files < HEJ £ 40 i F R AE2E MPEG2 video file (24 MP4 video
file » A 2 F R —TRIRAY bitmap file I - Al FREEAER

Microsoft bmp file -

41 RErEEERE T
@”

AW 7= A DARED i

4.1.1 FH/5E2BL5E Menu Bar 1Y File=»Save As

(01El 4-16 Fr)

") HiBestViewer -09.03

41.2

Viewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

[& 4-16 F Menu Bar By “#E{F A&/ M

TR T BB N - 208 G SR I Y
Context Menu - F{EE#EE Save As (Y& 4-17 Fi7R)

| Aoz View | tip View | Working View

OOI=s @

I C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03 bsi

lc

SetA

SetB

Set Selection As Range
Set Range Selected

Set As Zero

m—-u

) n
Lenth : m u
1000 g
FrameRate : Context Menu
99 fps ——— e
Image Size: =30 -10 3 |
1280X1024 -01212 -0.1010 -0.0808 ¢L__S:

Save As...

2
P 00202 0.0000

| | I 1 |
f T T

| 1 |
T

g

[& 4-17 H Context Menu Eg&) “HE{7{# A&/
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4.2

PRIF “EFEEREE

4.2.1 EEFEHEENEEOY Windows fZ#EfY Save As /1
[ > ERIE - (5 P8 T St FH G 1 1 T 2R AR TR R A
FEZE T - WIE 4-18 -

o503
File View Help
[ Acquue Vaew | 5t View | Working View |
Olujj==!
CA\Best Intech\HiBes{ @
WERO: - - 0@
| e F]WO) -8
.;;q;. Windows (C) DATA (D)
. - A — B
‘ﬁm.';mt w S B40GE = 372G8 v Sif* 162GB » =541 G8
% e | | premop * e ——
Image Size : AR -
1280X1024 < sio s =oesae 00202
= SESARNRZINER 6 -
amg 1
DVD RW M (E) -, ARSER G)
| <8 -~
b -, BRIEEH) —, ARXER D)
L — = ! . a
Q v v - “Save As”
aw  WREWOD  Vdeompt - user interface
FUMBD  [MPAFie (). -] WA
Save Options
© Save Entire Video
) Save Sub-Range 12 to 10
Frame Rate: 30
Ready

& 4-18 “Save As” (& E

4.2.2 %7(5? HEU AR T E T AR IR K HR
e TRV - DUE 4-19 BB e
H{ MP4 video file type Fyi{F{&AVEZAE -

AR N S - O @E
1) E 16} I -
'* X <
BE0E o Windows (C:) o DATA (D)
$e2840GB = 372GB #8 162GB  £541GB

m

- ITBETX)

sE =% [
S smoo e mmoce ‘
s GECARDREINERO A
oL ]
DVDRW E=# (E) - BERIXERG)
A $ -
- . BERIEEH) ~ BRAERD
@ - - -
RO oot -
7 =
TFER(T): P j RUH
Save Options e) Click to draw

@ Save Entire Video down the list

of converting
© Save Sub-Range -12 to (10 types and
select one of
Frame Rate: 30 A them.

[l 4-19 35 7E AR
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423 REFEEI(AE 4-20) A = (EEETH - SREAA T ¢
4.2.3.1 Save Entire Video : 7528 22 {[E7# 4% image data
file 2 FEF R S — TR ZE RS - AIEESLEE
JH -
4.2.3.2 Save Sub-Range @ 752 H 745 image data file §-
HEHY — AR S — A 2 A = - RIEE 758
H [ BLE A AT E R 4AHY Frame Number
K %% 1/ Frame Number ©
4.2.3.3 57E frame rate i={j& 1508 H E#E{F Y MP4 video
file #2=C Kz MPEG2 video file }8=\G%Y -
|-, .

VideoFile -

AAZaRBnABE -

«

BEEEMN): Video mpd
THEIBANT): [ MP4 File(*mpd)

Save Options

: » Convert whole image data file R
Save Entire Video : Convert part of

0 ¥-image data file

[ @ Save Sub-Range = to
} Set Frame rate. It will take by

{ Frame Rate:

4-20 B EfFTERERY

5 EHAEEEIEEA) Context Menu THAEHETE
EE R GEREIEE N - g EATEIUHE Context Menu » 41[E]
4-21 Fiis e

Acquire View | Stip View | Working View
OO0 EE=E o Image Thumbnail Area

C:\Best Intech\HiB r0.90. deoFile\2015-04-10-05-43-03 bsi /' [ ;]l
R Ce— T — T — — e
I

Lenth:

1000
FrameRate : -
99 fps SetA
Image Size : SetB
L -197 ‘ Set Selection As Range -104 103
19899 Set Range Selected -1.9596 -1.9495
In “Image Thumbnail Area” right click mouse SetAsZero
to show “Context Menu” Save As..

& 4-21 Ol Context Menu
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DL 142 Context Menu NEYIHEE -
5.1 SetA J SetB : %€ A-B Play & EX#1[E > 1[E 4-22 Fi7s ©
511 —{E{ERIEM A-B Play & B [ElfY 45 images &
& » ERYTHRY A-B Play & EGH#i[E /2 & A 1Y images
&t > JREN A-B Play & EGH#GEIY A BEGREAAEE) KSs—
st image frame - [fij B RH(%5H0) 8L E % —5k image
frame -
5.1.2 H%h#E Context Menu #HY Set A menu item 5% 7€ A-B Play
W EE a0 EY A REGEELGEE) - 40 &R B A 8
(FHVH BB 228 H R image) 17 /2 A-B Play 1 B
[ElHY A BE(EELARES)
5.1.3 [E]3 » BEEE Context Menu £ Set B menu item 27 A-
B Play [& F#[E]Y B Bh(4¢EE) -
5.1.4 WIRAEEE A BB B B - WHZA LA image 7 5E
HY > AR e E B E L& A 30 -
515 K - WHRA{EEE A BB B BilF - A —{ELL HAYEEEY
G (N TE S HAE images) - FRIEE 24 & R A BT 2R Y
Fy image(t il F 2 HL image i - FH 7 B 12 R85V A
si image) il e e ¥ 52 -

l Acquire View | Strp View | Working View

[ C\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi [x ‘
‘ 0 . 0o ! oz
“Lenth. = “ — ] e . e L N e
1000 Set “Apomt” of JA-B'P Rhnge™ y
FrameRate B
99 fps -
1280X1024 > pee
-200 Set “B pesint” of « I )g}? Set Selection As Range -194 193
-2.0202 -20101 -19899 SetRange Selected -1.9596 -1.9495
Set As Zero

Save As.

4-22 SE A-B Play [ B[

5.2 Set Selection As Range : 18-85 F & Frase VAV #48 images [&ES »
HREECERSy A-B Play & Bz - 41El 4-23 Fios -
5.2.1 BEH—{[EH%4E images & ELHR(F -
5.2.1.1 {si A EelREE H AEH4E images (& By H i — i
Ui Bl (RERGECARE)AY image - i1 1 & B EHRE
Ef) image EHAE -
5.2.1.2 1B HHEFZHY Curl key”Bi “Shift key” R i
By
5.2.1.3  FHE{ AR B BE 758 H 15E /828 images W EZ Y 55— (i
Uik > (R TE S G E H A4 images (& B
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PWRTAEHY images # & #AER
5.2.2 SERkEERL—(E#E4E images [ F% 1% » BhiEE Context Menu
1Y Set Selection As Range menu item 7z € A-B Play
W F & -
5.2.3 YISELEEN{T Set Selection As Range B » 37745 (F (A&
sz » Rl e e EhE Ry -

"o HiBestViewer - 0.0.0.3

File View Help

Acquire View | Stip View | Working View
[Oml=l=[=]=]g

| C\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi

!l»~!l.»~u; K -
] M @ lay Range”i SetA

SetB
[ ]

SetRange Selected

Image Size :
1280X1024

Set As Zero

Save As..

4-23 %7€ selected images ¢ £y A-B Play [& E5¢ & [&

5.3 Set Range Selected : £ {5 & select A-B Play & E& i [E #HAY A
H images > {7 menu item 7% - (HFFERFEE S| A-B Play
W EE R [E AT images & DI RAY T EUE ] - WIE 4-24
Fis ©

a2 HiBestViewer -0903
' Fle  View Help
Acquire View | Stip View | Working View

00 20= ©

[ cagestintechri 0.90.003\VideoFile\2015-04-10-05-43-03 bsi ]|
Lenth :
1000
FrameRate
99 fps
Image Size
1280X1024 SetB
_ SetSelection AsRange
“{SetRange Selected
« = P C
SetAs Zero
Save As...

4-24 A-B Play [&ESE[EIHVFTA selected images

5.4 SetAs Zero : {5 7E image (B[ selected image)iy Frame Number
SRS RRE & 0 0 [FRF RSk IE RS A
image Y Frame Number R AH¥IRF[H] > DU 4-25 Sffl] - P
JFZRAE Frame number -200 F#arY7#4E image BRI E
Frame number 0 « 554 » DU N2 R{EFISMARSLATERE

34



5.4.1 UISRAEAL Set As Zero B - 3% A ({0 image #75EHY
LR E B ERNERY -

542 [z W15A{FE Set As Zero i » H—{ELL_EHY selected
images (WhiE f& 2481 images) » FRJEE 2478 & £% FH B T 1%
HyHY image (th@t/21E select image [F » % B (% B 58
HIHRE image)fi Ryt iE 0 B -

Acquire View | Stap View Worhng View

C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03 bsi

o mm----m
1000

FrameRate

99 fps Set selected image’s frame munberAs 0
. I —

4
1280X102: 5558 == S Set Selection As Range 19‘ '193
-20101 -2.0000 -1.989¢ Set Range Selected -1.9596 -1.9495
« B ==x 1 SetAs Zero 0
" Sglected i e i ris =2
¢lected image. Its frame number is -200 e A

and highlighted.

l\ Acquire View | Stip View | Working View

C:\Best Intech\HiBestViewer_0.90.003\VideoFile\2015-04-10-05-43-03.bsi
= --m-m-- .
1000

| FrameRate
99 fps

|image S I I N N —
5 6 7

1280X1024

1 2 3 4
0.0101 0.0202 0.0303 0.0404 0.0505 0.0606 0.0707

R
L Seleeted image. Its frame number is
changed as 0 and highlighted.

4-25 Set As Zero IfEE

55 SaveAs... ! It menu item AYIAEE » EEEEEENY image HYE

T R R H BN video file 22 —5E—5E[Y bitmap files -
HEDIRERVE R R S R AR 2 4 -

H Strip View {JJ# % Working View

RN G AR EIEE AN > F e B EE g — 2 (double BEZEE) » At

H Strip View {JJ#4 % Working View - tJJ# %] Working View % -

Working View #1YfE55H (Play Head){iL & - &) £ H#& {E Strip

View # ] 75 E S8 A H R 52 B2 4B (Image Thumbnail) FrEHI{ILE

I
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FAE Working View » EFERRT KRG E K

AR BRI {5 FF HiBestViewer & Working View e ffrfy s
images ZHHEEE IR 15 R — Lo A -

1 a2 Working View

HLUT @A DAYJ#aZE Working View o {H 75 4:1F Strip View

FAEIEZE » #A1&F H Strip View UJHAE] Working View » 7 REHE (R

Working View BURHIIEZ FE Strip View 2 FiFTFHRIIRE % -

1.1 HFEAEMAE LA E SRS Working View tab (411& 5-1
FR) o JEE - FH DA FBUAE—E AR AT
MR GHE R » B H ORI EEGREE - ERIT
i8E Strip View J# % Working View [/J#2/E » Working View
FEER—RZH -

| o HiBestViewer - 0.9.0.3

|

File View Help

Acquire View | Strip v-

5-1 H#HH5 L5 Working View tab
1.2 H Strip View tJJ#2 % Working View : 7£ Strip View #HYE~E

GAmEE RS N > HE B (double ER75E)FEEEH Strip
View tJJ# 2 “Working View (Z[&] 5-2) -
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(%0 HiBestViewer-09.03

File View Help

Ammv.w]smpv.w‘
| | e | u || ® p‘

il il = 0 fps
< Il » &
o —|T:08081 A:-200
{- = p a0 B:799
-2.0202 0.5051 3.0303 5.5556 8.0707
-2100 50 3?0 5.?0 799
ls“o[smls:a R-R-R<R>
Slow ) Fast
Play Step |1

(Step of playing by frames)

‘< ‘>

5-2 H Strip View tJJ#2 % Working View

IR

B RITE S /i 3t
Control Buttons) (2)3&HLIREES

T3 R FLRER ST

L (D)FRREzERIT (Play
Z:M\(Play Status Information) (3)#% /i i

fE e (Play Progress Bar) (4)$& S K i& Ll Fg (Play Frame Rate &
Play Step Interval) (5)#& iz 45 R i &5 F B oras i (Play Display
Windows & Display Settings) @ [1[& 5-3 7~ ©

(e HiBestViewer - 1001

iE5)
Eilal o g Help Display Settings

Vindow &

(1) Play Control

Acquiz View | Stip View | Working View Buttons— Information
Rt || 22 ’ p‘ ﬁ‘ e |
: o — —_— N\
| 0 fps
<nplel
— 12 1~ 1 -1|T7:08283 A:-200
I« l" ’-)Hbljmz B:799 @
) ) e >
-2.0202 0.5051 3.0303 5.5556 8.0707
-200 5|0 3?0 550 799
. * l A 3,
seto | seta | sets R-R-[R<[r>]
Slow J  Fast
Play Step 1
(Step of playing by frames)
Comment I
(4) Play Frame Rate & < \Tl
Play StepTntervat
Ready

(2) Play Status

Hlay
Prd?‘css Bar

5-3 FRRZERINY AT 77
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(S FH 3 R A1 a3 e e AR OSERTB T R AR IV » 1

MAEZEE PR ITEE image BERIA S FOH4 image BERITHEHY

OENRAG » LN 8 —E 8y TRE

2.1  $ERZEE#T(Play Control Buttons) » $£75 8 {[& Play Control
Buttons :

2.1.1 E (Reverse Play Button) : {5 FH 75 BB IE button &5

5 Working View & H #1755 (Play Head)Fr{E iz EAL -
R RIRR T image R » B FI{E A #RGEERS Stop
Play Button B¢ & %52 A A-B Play [& EE#uEIAHY
image £k} -

2.1.2 @ (Stop Play Button) : {5f F 75 Bl EL 25 1 button {15
IEAE TR U IE » R AT BRI R T
HRFE R e R R -

2.1.3 \E (Normal Play Button) : {55 F & L ELiEE 1L button /B

5 Working View & 5 #5755 (Play Head)Fii7E i B L -
RFPIE &Y image Bk » B #I{5E A &R Stop Play
Button =& LG 5E A A-B Play & B #0[E N HY image
2.1.4 @ (Cyclic Play Button) : [t button J& 2k 5a ELEFEEA
TEERFEIUES - & BAREERRE U= - 5 (E button

Wk AR (B TR AR B

We i —A% button BISME » AnE 2 -

f PHREEE IR T > FEFERGE image BRMZ (f
smlE R B RITRTR) - R FRr A S AR TR -

2.15 M (Move to A point Button) : {5 B & B BE2EE 1 button 18f

[EFSFEEA (Play Head)2 8l 2= A-B Play [ ELHE[E Y
A Eh(t 2 A-B Play [ ERAUFERES) -

2.1.6 w (Reverse Step Play Button) : {5 F & B BE25E 1 button

HH#E1S Working View & H #1155 (Play Head) FiifE (L &
#e > M R UJ#—5k image &k} o
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2.2

2.3

2.1.7 (Normal Step Play Button) : F& B ELEE L button

{5573 Working View & = “RE i 5H(Play Head) Fr{E(iL &
e (RFPIE A UJHA—5R image &k} -

2.1.8 \E (Move to B point Button) : A& B BEEE [ button 1

{15 IHE(Play Head)#2 8% A-B Play 1% EX &3 [E ¢y B
BL(tsl2 A-B Play EEZHYZ%ED) -

TEIUIRREEER (Play Status Information) » AL 5 fIRREE

af

221 FERUEE B ISR image HYTRERR 2
(fps =» frame per second) » #1[&E 5-4 Fi7 °

222 ‘EREREEAFTEME © SEEEH > & H Frame
Number Jz Relative Time (DLFD 5 EEAT - FEHE 2 /NELRE
PUNEEIUfn) 2R - 20iE 5-4 Fios e

2.2.3 A-BPlay @EEZH#IE © ES{EEIEER - &M A RFTERY
Frame Number &z B BLFTfERY Frame Number ZRZE7 »
W&l 5-4 Firs -

Current “Play Head” position. v Play' §peed.
T : relative time by second 3015 fps fps : frame per
F: frame number ¥~ second

~ T -1.1212 [ A.: -200 | | A-B Play Range.
F:-111 B:799 *AA point by frame number

B : B point by frame number

5-4 #EFARAEE N (Play Status Information)

TEIBUAEE {FR(Play Progress Bar) = fEBUAERERER T AT LB A 8k
B2t ERER s E A-B Play W& EZ#iE K R 1B i EE
L EHVIRAIE -

231 FHEPBUEE R - BEAEERAR T 2 EHYHEE image
&t HEERRAY ETEAZIE - RS HHERY Frame
Number k7 Relative Time (DLFD B B0 - FEHE 2 /NELERE
PUN i) » 40k 5-5 Fow e

(55505 ChET 30303 5 EEEE 80707 Relative Time
s B ki) 550 799" » Frame Number
e .
® ' Progress Bar

5-4 FECEL R (Overview)

232 (rERIRFFR @ A TERCEE R 8BS 3 MU BN
9% -
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2.3.3

2321

2.3.2.2

2.3.2.3

b (B - Play Head BERIFSR) © s H Al
EREEFT R B - SR AERIEN I B E
o R EEREIUNEERGE SR 2.2.2 1Y
SiH) - BRERUEITEY - REEER LB EN
i B & RNE G PE R TIm EhRE ST -

5541 » Working View FUFERIIEE HEE(E A-B
Play & B #i BN T » RIS RRI ST 1
A-B Play & EG#i[E 2 A1 - {5H S E BURG e
{T-—7& play button (&#%1“Normal Play” >
“Reverse Play” »  “Normal Step Play” - ...)&}
A o BRI I AT DA A% A-B Play (&
o anE 5 H 5 B EREE Move to A Point Button (&,
= Move to B Point Button) » <& jix0E% A A-B
Play & B [E 2 [N -

\ (A-B Play BELFEIIISEL TSR © 148

HOMEREE | - S TIE A-B Play B EX RIS
ERLTRTSE » (T T T A
BT A BEAACE - AT AR B Bk
fir's > 45 A-B Play [ B3R RO (R
S I AR EET: - TSI A-B Play

EEREI i EE R T AR
S GESR 2.2.3 HERE) -

2 A B T — (RSB e - BT A
W B BEAO AL BRI - DL AT R
SR LT R AT — (B g -
(o P12 T 1 B e s B S
BB BT SR B R RS - R TR

B)

¢ (EEETE) | FE SRR
B TS EE RS - RO -
BIREE 0 SRS (MRS - SEHAEAT
S/ EETE -

PRI EAURITHR © (L& ] DUR S B2 SR (E (IR R
FEE BRE A BOBE AT SE N 7Y B 2 AR

5t -
2331

P ERHEES o (RBICEY) o T DA iBi oy
8 HEEIEREROBRR T LR o (B
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o YR EE L ETE A-B Play B ESEIE 1 -

2332 HI/EESME . (A-B Play [ E i B H b5

%) 1] DAL A-B Play B #ifE -

2.4 REIUERFE KRB PR (Play Frame Rate & Play Step Interval) : i
FI AT LASOE REURE (LA frame per second /5 8E4r) » BARG
TESRIUR » B —IR image 1% - BN —5REEE Y image
HIMH ¥ EEREE (2L Frame Count £y 5Air) » H13k/2 Frame Number
ARG SR R
2.4.1 ELEREUERE (DL frame per second yEEAr) : FHIE ELHE

=3 Play Speed Slider » 1 Slider i~ 5 & i< B FEAY 15
RS - 4fE 5-5 -

Slow Fast
— [~ “Play Speged
‘ - Slider” and
Play Step 4 . its value.

(Step of playing by frames)

5-5 Play Speed Slider Kz EL¥FEAVRE S

242 EEREEEE(Play Step) : FHI7E EEGEE Play Step
ComboBox 7k E RGN EEE > A& 5-6 -

Slow O Fast
[Play Step 4 | I Set “Play Step”

(Step of playing by frames)

5-6 FIE fE X (Play Step)

25 FEIGERERE KE e E (Play Display Window& Display
Settings) : &4 image BRI - (EFHF & 1E Play Display
Window FE[FEREER < FrIL 24N > BEH IR DU N HEREE
S > E 5-7 Fros o
251 “Fit” : AR E S Fit to Window 75t 2 Preview

Window YA/ » FHAZFUR H B EEUR -
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25.2 “1:1”: % image Y E PR A/INREE TR » FHFY image Ay A
/NEE BN Preview Window FYA/)N > (RIS
TEEREST » TR R & EF| image AYEL T ©

2.5.3 Zoom In/Out : {55 B EL7E ¥ FERY button B[JE] -

T eE——)

‘4 “'i > @ 3088 fps

T:1.0202 A:-71 ‘

‘F }:‘ ; ; F:101 B:617

-2.0202 0.5051 3.0303 5.5556 8.0707
-200 50 300 550 799

o L e s

[ seto [ seta | sets R-R-JR<R>]

Slow U Fast

Play Step 4

(Step of playing by frames)

Play Display Window
,<

=

eady

5-7 FRRAE R R B B Rak

Woking View H'E¥E(E
£ “Working View”##2 5755 1 DU MEE © (DaxEi5aEnY image £y
frame 0 (“Set 0”) (2)5% 7 A-B Play & EX#i[E Y A & (SetA) (3) &xiE
A-B Play & FL#a[ElHY B B (Set B) (4) ¥t /FERE 8 M BB ITEE
E2%M1E (Add/Remove Bookmark & Move to Next/Previous
Bookmark) (S)#rig/ME U/ MbRE: 0 AL B IE 2 a0 B
(Add/Modify/Remove comment & Move to Next/Previous comment (6)
B image _EFEE L ERYEEAE(DA pixel FyEEAL) » DL EDhRER I
3.1 EERRIMEARTAEL EHY image £y frame 0 © {5 175 EURiEE Set O
button » Z &Rk & RHEREEFTE AL ERY image 3¢ & 5y 0 > 5k
BB image /Y Frame Number Rz AH S5 E By 0  [EHF Z478
R MEFAH R M BT image Y Frame Number JzAH ¥
fi - W& 5-8 » 35 BLfF Strip View {7 Set As Zero HYAE-EFH
[EHY o (AZEIUEERY 5.4)
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e e

A:-171
‘KH HI)H)I F:O B:517

-3.0303 -0.5051 7 2.0202 4.5455 7.0606
-300 50 / 200 450 699

4. ¢!
Cooo foea o] @RISR

5-8 SUETRIEHAILE R O

32 EERBUEMFTEALERY image fy A-B Play [&EX#EE#AY A
Bh  (SH S B BEE Set Abutton > Z AR EEERHE A FTEAL
B lmage S Ry A-B Play & Be e [E Y A B > 0fE] 5-9 -

‘ " \‘ > ! 3088 fps
|

el ]u\l;:;{ff?,,

-3.0303 0 5051 2 0202 45455 7.0606
-300 200 450 699

[} L‘ ' I ' ‘l l il |
EIENEDRN B E BN
5-9 BEfEGRALE Fy A-B Play LR ELH[E AT A Bh

3.3 EEFBIUENVRTIEIERY image £y A-B Play & E#u[E Y B
BE: [ A S BRI Set B button o Z47 5k E iR IEE R FTAE AL
B image 5% & By A-B Play & ESHEE LAY B Bh > 41[E 5-10 -

". 3088  fps
P

/
-3.0303 -0.5051 2.0202 45455 /  7.0606

JPD -50 ZKIJU 450 / 699

R L o4
(oo (oo (o] IR RJA]
5-10 3 EHLHH{IE £ A-B Play BRI B %

3.4 Friw=E%(Add Bookmark) : Fygeambse R-| putton » 2455k e
FyfE A PR AL B 00— & AEa0 - S BERNI L E
RO A EESEC o RIELE RIS - 2fE 5-11 -

z/ ‘E E @ 3088  fps

) —|T:-1.2525 A:-171
H‘ & 5 ‘N F:-124 B:517

-3.0303 -0.5051 2.0202 4.5455 7.0606
-JIUO -50 ZE'ID 450 E?
1 i " 1
YOUSRRRNNY Y

| seto { seta | sets j [ﬂ - ‘ﬂ<“l>]
5-11 R RRIHAV P A B hl— (B E 8ise
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3.5

3.6

3.7

3.8

4% (Remove Bookmark) © {5 FEE %% R button » %
S BRI IH PR TE L B EE AT - S ERBIBEENY
L' EXDe A EEAC - HEFRA g AR - WIE 5-12 -
‘T ‘F T E 0 fps
‘: ‘: : T:-02424 A:-71

Pl [F:-24 B:617
-2.0202 0.50: 3.0303 5.5556 8.0707
-200 5[0 300 550 799

R Y

| Set0 || SetA Set B R+ R - l<|l>|

¥

4« ll » 2 o M
— I T:-02424 A:-71 ‘

M & = p| B:617
-2.0202 0.5051 3.0303 55556 8.0707
20 % 3 s 79
TR
Set0 ‘ SetA | sets |_+l_<\M
5-12 FEERIEHEEIPTEAL B E B

TSR IH 2 A — (8 &V (i2 & (Move to Previous

Bookmark) : Fi& Ee RhiEE button » 5 F& AR & AT AEAL

B AE A —HEE A GgiEBruaise) 2z =580

LB E - FHERBIBEENE RIFTE AL B 2 A A S &0

R LB RS -

P ENRRIE 2 1% —(EEZF AL E (Move to Next Bookmark) :

VR BB button » = HEREEN & HIFTENL B 2 1R IFAEH

—(HEE - AFRHFI RIS EZEENIE L - 5

FEIORNE RIFTE AL B 2 (R0 A S B0 - AItE/ER %

b e XU b 0 (Add/Modify/Remove Comment) © {85

H]LIAEFEEHT image Bk BT /ECUMIEREEET - DU TER

HAAOAT A -

3.8.1 KEIEESEIRTEER image (ILE - (HHE A LA A
EREIUIREEE L (Play Status Information)zkktERE H Bk
TR AEAL B - ik v] DASTH RS B S R S B
BEZEf5ER image FYFTT - FF Forward Step Play =
Reverse Step Play {55 i BE% Eh 2] H IR & | > DUE 5-
13 Af » EF5EAF Frame Number % 100 Ay image |-
it -
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3.8.2 ZRBELE AT Comment 4RIk (Comment Editor Area)
INIIFTA SR EAVEEED - AR ESEHPR 2T E
(rRERT > DAIBI 5-13 BB > BeTRHSEAE Frame Number
B 100 1 image 2 _|= T “This is a test!”fi Bar a0

Current “Play Head” position
*, 0 fps

<« nr»le
— — | 2710101 A:-71
|« 5 M
-2.0202 0.5051 3.0303 5.5556 8.0707
200 5% 30 %0 7%
S e
set0 | setA || sets | R+ R-R<R>|
Slow U Fast
Play Step 1

Comment Functions Area
(Step of playing by frames) A

Comment Editor Area
A

[<][>]

This is a test!
User Comment

5-13 e MfEduim ks 0 (Add/Modify/Remove Comment)

3.9

3.10

3.11

ZEhE e 2 B —{EEEEL N & (Move to Previous Comment) :
fEFEyE e (< button - AISEREREETE RIFTE A E >~ A E
A —EEE - RS EitEieas e 2 sdavfuE o
[EI L &R L B _EAVEESCE U Comment 4R &I A o
AT TR A & FIFT AL B 2 B2 Comment » HIHLEI{E
BI4ERY o

M ENEIH £ 1% —(EFEEC I (Move to Next Comment) = A7
BRI 12 button » ZHEREHY & FIFTENL B 2 & FA1EH —{E
ELAL AWMU B B e eCaV U B o [FIFF L
s FAYERECEE T Comment 4REREIRA - HERERT
BEAY & RIFTEAL B 2 %1124 Comment » Al FLEFRIAERY -
iR image FFE7E T BEAVFERE(LL pixel SEAL) © & THEE
image FAVMIE @ (EHBFEFHET-FEML TR » ABHE
RIGE image EAVIE - (EIMEEIZALEAVEAE - DUTRERAEA
P ER

3111 (A E A LAFE B T button s B S
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TFEMTE > e TERE  EHEGER
T g5 (Play Display Window) 575 R — (&l EE (i
5 L HR R R G E (Play Display Window)Shy
A EARRA T LB B E - A8 5-14 - L1IR(E
R E(E e TR - AR R e

button —ZKE[IA]

3.11.2 Zi% - (EFZE T HE ERS BRI R (i (Play Display
Window) NEVE(TLE - BEHstae R+t ORI B
{5 AR AR E - YA E e iR
EOEEHIIE L -

~ . T7e) L ss /Off i 0]
Coordinate value of “Cross Point /'Tum On/Off Cross Line Button

[ o View [ St View | Working View

L
o )l=)l2) 2]

2 e ey 0 fps
i
—r—r 1|T:08283  A:-200
I« ‘ﬂﬁ‘ | = M) B:799
-2.0202 0.5051 3.0303 5.5556 8.0707
-200

HVERER S

Set0 ‘ SetA L SetB ‘ [l +J| - R« ‘[l 5|
Slow U Fast
Play Step 1
(Step of playing by frames)

5-14 FrR image EF57E L EHYEAR
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BAE EREE

1. ZEfE

3

85— PCl Express x1 Gen2 USB 3.0 IE £ » # RSP (L USB 3.0 4@ - &5
BHELLENE -

* s EEE L -4 PCI Express USB 3.0 5 75-F4#%!] PCI Express fa#if# o
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H PRI SRR EFL - (2 = AR 2R IR GRS e iy -

R

1/4"-20 UNC

USB 3.0 &7 — Ui Micro-B 1255 18 £/ i 2R I AHA% A USB 3.0 Micro-B f8ifE - RFRAT
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